REN ESAS Application Note

RA4W1 Group

Bluetooth Mesh sample application

Introduction

This document describes the sample application which uses the Bluetooth® Mesh Stack. Bluetooth® Mesh
Stack is the software library to which is used to build a mesh network that is compliant with Bluetooth Mesh
Networking Specification and to perform many-to-many wireless communication.

In this document, the Bluetooth® Mesh is referred to as the Mesh.

For more details on how to perform the Mesh demonstration which uses this sample application, refer to
"RA4W1 Group Bluetooth Mesh Startup Guide" (RO1ANS5847).

Target Device
RA4W1 Group

Related Documents

e Bluetooth Core Specifications (https://www.bluetooth.com)

o Mesh Profile Specification (Search for “Mesh Profile 1.0.1” in https://www.bluetooth.com)
e Mesh Model Specification (Search for “Mesh Model 1.0.1” in https://www.bluetooth.com)
e Renesas Flexible Software Package (FSP) User's Manual (R11UM0155)

e ¢?studio User's Manual: Getting Started Guide (R20UT4374)

o RA4W1 Group BLE sample application (RO1AN5402)

¢ RA4W1 Group Bluetooth Mesh Startup Guide (RO1AN5847)

e RA4W1 Group Bluetooth Mesh Development Guide (RO1AN5849)
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1. Overview

1.1 Demo projects
Projects for the sample application accompanying this document are shown in Table 1-1.

Table 1-1 Projects

Project name Description
ekradw1_mesh_client_baremetal Client Models project for EK-RA4W1 not using FreeRTOS.
ekradw1_mesh_client_freertos Client Models project for EK-RA4W1 using FreeRTOS.
ekradw1_mesh_server_baremetal Server Models project for EK-RA4W1 not using FreeRTOS.
ekradw1_mesh_server_freertos Server Models project for EK-RA4W1 using FreeRTOS.
ekradw1_mesh_cli_client_baremetal Command Line Interface (CLI) project for EK-RA4W1 not using

FreeRTOS.
ekradw1_mesh_cli_server_baremetal Command Line Interface (CLI) project for EK-RA4W1 not using
FreeRTOS.

These projects can work on an EK-RA4W1 board.

The Server Models projects perform Server model. They receive messages from remote device (e.g. smart
phone) performing Client model, then blink the board mounted LED, and display the received strings.

The Client Models projects perform Client model. They support CLI which can be accessed by using a
terminal emulator (e.g. Tera Term) on a PC by connecting it with an EK-RA4W1 board via USB cable. They
send messages to the remote device performing Server model by pushing the board mounted switch or by
using CLI, then blink the board mounted LED, and display strings on the remote device.

(

EK-RA4W1 board
Server application ﬁ": Client application Terminal

EK-RA4W1 board [ ———

Smartphone (Client application)

Figure 1-1 Projects overview (Server and Client)
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CLI projects can perform all models defined Mesh Specification. They can perform various procedures
relating to the Mesh by transmitting and receiving messages using CLI.

EK-RA4W1 board EK-RA4W1 board

lcLi server application CLI Client application

1 1

Figure 1-2 Projects overview (CLlI)
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1.2

Mesh Stack features

The Mesh Stack provides many-to-many wireless communication features which are compliant with
Bluetooth Mesh Profile 1.0.1 Specification and Bluetooth Mesh Model 1.0.1 Specification. This stack
supports the following features.

Bluetooth Core Mesh Profile features:

Provisioning (both Provisioning Server and Provisioning Client)
Access

Upper Transport

- Friendship (both Friend feature and Low Power feature)
Lower Transport

Network

- Relay

- Proxy (both Proxy Server and Proxy Client)

Bearer

- ADV Bearer

-  GATT Bearer

Foundation Model

- Configuration Model (both Configuration Server and Configuration Client)
- Health Model (both Health Server and Health Client)

Bluetooth Mesh Model features:

Generic Models

- OnOff, Power OnOff, Power OnOff Setup
- Level, Power Level, Power Level Setup
- Default Transition Time

-  Battery

- Location, Location Setup

- Manufacturer Property, Admin Property, User Property, Client Property
Sensor Model

- Sensor, Sensor Setup

Time Model

Scene Model

- Scene, Scene Setup

Scheduler Model

- Scheduler, Scheduler Setup

Light Models

- Light Lightness, Light Lightness Setup

- Light CTL, Light CTL Setup

- Light HSL, Light HSL Setup

- Light xyL, Light xyL Setup

- Light Control
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1.3 Software Architecture
Figure 1-3 shows the software architecture using Mesh Stack.

Mesh Application

Mesh Stack API ——  — Driver APIs —

Bluetooth Mesh Stack

Bluetooth Bearer API )
Peripheral

Driver
Modules

Bluetooth Bearer (Bearer Platform)

R_BLE API

Bluetooth Low Energy Protocol Stack

MCU

Figure 1-3 Software Architecture

The Mesh Stack software is composed of the followings:

Mesh Application
The Mesh Application is an application which performs features provided by the Bluetooth Mesh Stack.

Bluetooth Mesh Stack

The Bluetooth Mesh Stack is a software that provides applications with many-to-many wireless
communication features which are compliant with Bluetooth Mesh Networking Specifications.
Bluetooth Bearer (Bearer Platform)

The Bluetooth Bearer is the abstraction layer that provides wrapper functions of Bluetooth Low Energy
Protocol Stack.

Bluetooth Low Energy Protocol Stack

The Bluetooth Low Energy Protocol Stack (hereinafter referred to as "Bluetooth LE Stack") is the software
that provides the higher layers with wireless communication features which are compliant with the
Bluetooth Low Energy specifications.

A Sample program of Mesh Application is included in the demo project included in this document.

Bluetooth Mesh Stack and Bluetooth Bearer are provided as FSP.
Bluetooth LE Stack is provided as FSP.
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1.4 File Composition
File composition of demo project is as follows:

ekradwl_mesh_xxx_yyy Project folder
+---ra\fsp\inc\api\
| r_ble_api.h Bluetooth LE Stack Header File
[ rm_ble _mesh_xxx_api.h Mesh Stack API Header File
| rm_mesh_bearer_platform_api.h Bluetooth Bearer API Header File

+---ra\fsp\inc\instances\

| rm_ble mesh_xxx.h Mesh Stack Header File

| rm_mesh_bearer.h Bluetooth Bearer Header File

| rm_mesh_xxx.h Mesh Stack Header File (Model Feature)
|

+---ra\fsp\lib\r_ble\ Bluetooth LE Stack Library
+---ra\fsp\lib\rm_ble mesh\ Mesh Stack Library

I
+---ra_cfg\fsp_cfg\

| r_ble cfg.h Bluetooth LE Configuration
| rm_ble_mesh_cfg.h Mesh Stack Configuration

|

+---src\ Mesh Application

To use the features provided by the Mesh Stack, the Mesh Stack must be added to a project. Regarding how
to add the stack to a project, refer to Chapter 3 in this document.

1.5 API Specification

To perform the features provided by the Mesh Stack, it is necessary to use the API of the Mesh Stack.
Regarding the specification of Mesh Stack API, refer to "Renesas Flexible Software Package (FSP) User's
Manual (R11UM0155)".
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1.6 Operating environment
Table 1-2 shows the confirmed operating environment for hardware to build and debug the demo project.

Table 1-2 Hardware environment

Hardware Description

Host PC Windows® 10 PC with USB interface.

MCU board The MCU used must support BLE functions.
EK-RA4W1 [RTK7EKA4W1S00000BJ]

On-chip debugging emulators The EK-RA4W1 has an on-board debugger (J-Link OB),
therefore it is not necessary to prepare an emulator

USB cables Used to connect to the MCU board.

Table 1-3 shows the confirmed operating environment for software to build and debug the demo project.

Table 1-3 Software environment

Software Version Description
GCC e? studio 2022-10 Integrated development environment (IDE) for Renesas
environment devices.
GCC ARM V10 C/C++ Compiler. (Download from e? studio installer)
Embedded
Renesas Flexible V4.2.0 Software package for making applications for the RA
Software Package microcontroller series.
(FSP)
SEGGER J-Flash V6.86 Tool for programming the on-chip flash memory of
microcontrollers.
Integer types ANSI C99 “Exact width integer types”. These types are
defined in stdint.h.
Endian Little endian
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2. How to use demo project

This chapter describes how to use the demo project included in this document.

2.1 Importing demo project
Follow the steps bellow:

1. Launch the e? studio and select the workspace directory.

8 ¢ studio Launcher X

Select a directory as workspace

e” studio uses the workspace directory to store its preferences and development artifacts.

Workspace: ] C:¥MyWork¥radw1_202110 R Browse...

[] Use this as the default and do not ask again

» Recent Workspaces

Figure 2-1 Select workspace

2. Select File > Import.

&) rasw1 202110 - €* studio
File Edit Navigate Search Project Renesas\iews Ru
New Alt+Shift+N >
Open File...
L Open Projects from File System...
Recent Files >

Close Editor Ctrl+W

Close All Editors Cirl+Shift+W

Save Ctrl+5S

Save As...

Save All Ctrl+Shift+S

Revert

Move...

Rename... [
] Refresh F5

Convert Line Delimiters To >

Print... Ctrl+P

Import..

Export...

C. B

Properties Alt+Enter

Switch Workspace >
Restart
Exit

Figure 2-2 File menu
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3. Select Existing Projects into Workspace and click Next button.

Q Import
Select

Create new projects from an archive file or directory.

Select an import wizard:

R2q

|type filter text

~ [= General
& Archive File
4 CMSIS Pack
- Existing Projects into Workspace
2 File System
1 Preferences
4 Projects from Folder or Archive
& Rename & Import Existing C/C++ Project into Workspace

Cancel

Figure 2-3 Select an import wizard

4. Select Select root directory, click Browse... button and select the demo project folder. Click Finish
button to import the demo project.

& Import

[m| X
Import Projects =
Select a directory to search for existing Eclipse projects. |
@ Select root directory: | C¥MyWork¥radw1_202110¥r01an5848)j0100-radw1 - ‘ Browse...
(O Select archive file: C¥MyWork¥radw1_202110¥new2 zip Browse...
Projects:
[~ ekradw1_mesh_server_baremetal (C:¥MyWork¥radw1_202110%r01an5848j] Select All
Deselect All
Refresh
< >
Options
["]search for nested projects
Copy projects into workspace
[]Clase newly imported projects upon completion
[‘JHide projects that already exist in the workspace
Working sets
[] Add project to working sets New...
Select...
@ < Back Next > Cancel

Figure 2-4 Import Project
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2.2 Building and debugging
Follow the steps bellow:

For more information on debugging with e? studio, refer to Chapter 5 in "e? studio User's Manual: Getting
Started Guide" (R20UT4374).

1. Select [Build Project] in [Project] menu or click the Build icon to build the project. In [Console] tab,
if you can see "Build Finished" message that follows build log, the build is successful.

. . . . kradw1 h b
You can see and change the current project with Launch Configuration = <@4¥!-mesh_server barer

After building, the firmware (.srec file) is generated in the "Debug\" in the project directory.

2. Connect EK-RA4W1 to a PC.

3. Click the Debug icon to launch the project in debug mode.
After launching the project, the firmware is downloaded to EK-RA4W1.

1l g

4. Click the Resume icon on Debug Perspective to run the project.

After debugging the project, click the Terminate icon L on Debug Perspective.
Firmware of the project remains on the flash memory of RA4W1 even after termination and power off.

To perform the demonstration, it is recommended to use at least two EK-RA4W1; one board works as a
Client and the other works as a Server.

NOTE: When the error indicating "No toolchain set or toolchain not integrated." occurs and building fails,
open [Project]>[C/C++ Project Settings] and move to [C/C++ Build]> [Settings]>[Toolchain] tag,
then set the toolchain (9.3.1.20200408 or later).

8 Properties for ekradw1_mesh_server_baremetal o X
type filter text Settings Arov g

Resource
Builders
v C/Ce+ Build
Build Variables
Environment
Logging
Settings Name |GNU Tools for ARM Embedded Processors (arm

Tool Chain Editor
/C++ General Architecture ARM (AArch32) v

Configuration: |Debug [ Active] v |Manage Configurations...

® Tool Settings % Toolchain & Build Steps % Build Artifact [ Binary Parsers | ¢ | *

mcu Prefix arm-none-eabi-
Project Nat
ject Natures Sufiix
Project References
Renesas QF C compiler o
Run/Debug Settings C++ compiler
Task Tags Arch
Validation rehiver
Hex/8in converter
Listing generator
Size command size
Build command make
Remove command
Create flash image
[[] Create extended listing
Print size
Use integrated toolchain versionf (93120200408 v

El Se]e [@][@
3 gl&| ™ |+’
Z IS
£lg
E]
3|12

Per project path Browse...

@ Gl
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3. How to make and configure new project

This chapter describes how to add Mesh Stack to a new project by using FSP Configuration in the e? studio.

3.1 Create a New Project

1. Launch e? studio and select [File]>[New]>[Renesas C/C++ Project]>[Renesas RA]. In New C/C++
Project dialog, select Renesas RA C/C++ Project and click on the Next button.

ﬁ New C/C++ Project ] X
Templates for Renesas RA Project

Renesas RA C/C++ Project

C/C++ FEE™ Create an executable or static library C/'C++ project for Renesas RA.

Figure 3-1 Templates for New C/C++ Project

2. Enter the project name and click on Next button. The project is named sample_appl in this document.

Q Renesas RA C/C++ Project [m] X
Renesas RA C/C++ Project f—
Project Name and Location

Project name

[sample_appl

Use default location
C:¥MyWork¥radw1_202110¥sample_appl Browse..
default
You can download more Renesas packs here
@ < Back Next > Finish Cancel

Figure 3-2 New Renesas Executable Project
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3.

Select the Custom User Board (Any Device) from Board, R7TFA4W1AD2CNG from Device.

Q Renesas RA C/C++ Project O X
Renesas RA C/C++ Project [
Device and Tools Selection
Device Selection
FSP Version: |3.6.0-alpha0+20211230.d166da01 o2 S T
Board: Custom User Board (Any Device) ~
Device: R7TFA4AWITAD2CNG
language: @ C O C++
Device Details
TrustZone No
Pins 56
Processor Cortex-M4
Toolchains Debugger
GNU ARM Embedded J-Link ARM ~
GCC ARM A-Profile (AArch64 bare-metal)
9.3.1.20200408 ~
@ < Back Next » Finish Cancel

Figure 3-3

4.

Project Configuration (Board and Device)

When making the MESH application on a BareMetal environment, choose No RTOS. When making the
application on a FreeRTOS environment, choose FreeRTOS.

8 Renesas RA C/C++ Project u] X ) Renesas RA C/C++ Project o X
Renesas RA C/C++ Project —§ Renesas RA C/C++ Project [
Build Artifact and RTOS Selection Build Artifact and RTOS Selection ,
Build Artifact Selection RTOS Selection Build Artifact Selection
@® Executable INo RTOS 1 @® Executable [FreeRTOS (v1043-LTS Patch2+1sp360.alpha0.20211230.d166a01) |
+ Project builds to an executable file + Project builds to an executable file
O static Library O Static Library
+ Project builds to a static library file + Project builds to a static library file
O Executable Using an RA Static Library O Executable Using an RA Static Library
+ Project builds to an executable file + Project builds to an executable file
+ Project uses an existing RA static library project + Project uses an existing RA static library project
@ <Back Finish Cancel @ <Back Finish Cancel

5. Click Next button.

Figure 3-4 Project Configuration
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6. When making the MESH application on a BareMetal environment, choose BareMetal -Minimal. When
making the application on a FreeRTOS environment, choose FreeRTOS -Minimal- Static Allocation.

8 Renesas RA C/C++ Project u]

Renesas RA C/C++ Project pr—
Project Template Selection

Project Template Selection

® %4 | Bare Metal - Minimal
Bare metal FSP project that includes BSP This project will initialize clocks, pins, stacks, and the C runtime environment.
[RenesasRA3.6.0-alpha0+20211230.d166d201 pack]

Code Generation Settings
Use Renesas Code Formatter

@ i Coee

X

8 Renesas RA C/C++ Project u] X

Renesas RA C/C++ Project pr—
Project Template Selection

Project Template Selection

® A | FreeRTOS - Minimal - Static Allocation

Empty FreeRTOS FSP project with no threads. FreeRTOS is pre-configured for static memory allocation. This project will initialize the
MCU using the BSP

[RenesasRA3.60-alpha0+20211230.d166da01 pack]

Code Generation Settings
Use Renesas Code Formatter

@

< Back i Next > Finish Cancel
Figure 3-5 Project Configuration (Select Template)
7. Click Finish button. After a while, the project will be created
B ro4w1_202110 - sample._appl/configurationam - & studio X
File Edit Navigate Search Project RenesasViews Run Window Help
4 Debug || & sample_appl Debug_Flat o | &R 5B E R @it CV AP SRR A R AT R e gl Q @ | B/ |4 FSP Configuration

[ Project Explorer 2| =% 7 § = O [{ [sample_appl] FSP Configuration 5% = SP Visualization X [rlXlaelel) =8
~ 1 sample_appl all2l2llr]l > in Function ~ lodule Name ~

) Indludes Summary Generate Project Content A 3 fo foe 5 Mool N

Era - L

= ra_gen Project Summary zenesas A I I II I I

@ src 1

& raclg Board: Custom User Board (Any Device) h RN

& script Device: RTFA4W1AD2CNG

 configurationaxml Toolchain: GCC ARM Embedded

R7FA4WTAD2CNG pincfg Toolchain Version: 9.3.1.20200408
sample_appl Debug_Flatlaunch FSP Version: 3.6.0-alpha0+20211230.d166da01
@ Developer Assistance Project Type: Flat
v
Selected software comnonents
° I'a
Support i =
Summary| BSP| Clocks| Pins| Interrupts| Event Links| Stacks| Components » A

[ Properties 5 |@ XY~k 7574~ rtlEy = ¢ © Console £ |(2 Problems xBR MBE-O~-=0
Property Value Eclipse Embedded CDT CMSIS Packs console

2022-01-13 22:55:57

Extracting devices & boards. . .

Loading repos summaries. ..

Parsing cached content file "C:\MyWork\Packages\.cache\.content_wmmi_keil_com_pack_index_pidx.xml"...
File does not exist, ignored.

Identifying installed packages. .

Found no installed packages.

Completed in 4ms.

No installed packages.

Completed in 4ms.

Figure 3-6 Project Overview
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3.2 Heap and Stack configuration

To allocate enough memory size to use as the Mesh Stack, set heap and stack configuration as following in
[Properties] of [BSP] tab on FSP configuration.

* [RA Common]—[Main stack size (bytes)]

¢ [RA Common]—[Heap size (bytes)]

0x1400
0x1000

Assert Failures
Error Log

Return FSP_ERR_ASSERTION
No Error Log

Clock Registers not Reset Values during Start Disabled

Main Oscillator Populated

PFS Protect
C Runtime Initialization
Early BSP Initialization

Main Oscillator Clock Source

Subclock Populated

Populated

Enabled

Enabled

Disabled

Crystal or Resonator
Populated

Subclock Drive (Drive capacitance availabilit Standard/Normal mode

Subclock Stabilization Time (ms)

1000

Custom User Board (Any Device)
Settings Property Value 2
~ RA Common
Main stack size (bytes) 0x1400
| Heap size (bytes 0x1000
MCU Ve (mV) 3300
Parameter checking Disabled

Figure 3-7 BSP Configuration

The configuration macros listed in Table 3-1 of BSP are changed by the above configuration.

NOTE: When you use the Mesh Stack, please be sure to change the following configuration.

Table 3-1 BSP Configuration and Macro

Configuration and Macro Default Value Value for Mesh
RA Common > Main stack size (bytes) 0x400
(BSP_CFG_STACK_MAIN_BYTES)
RA Common > Heap size (bytes) 0
(BSP_CFG_HEAP_BYTES)
RO1AN5848EJ0105 Rev.1.05 Page 15 of 43
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3.3 Clocks configuration

In [Clocks] tab of the FSP Configuration, select the clocks and set their clock frequency. To use the Mesh
Stack, the following settings are required.

e System Clock (ICLK): 8MHz or over

o Peripheral module Clock A (PCLKA): 8MHz or over

Bluetooth LE Stack is optimized for the case that the clock frequency of both the ICLK and the PCLKA is
32MHz. Thus, it is recommended to set the clock configuration in which the clock frequency of both the ICLK
and the PCLKA become 32MHz.

#* *[sample_appl] FSP Configuration X = B
. . ()]
Clocks Conflguratlon Generate Project Content
£ Restore Defaults
|XTAL 8MHz > ICLK Div /1 v —¥ICLK 32MHz
PLL Src: XTAL > PCLKA Div /1 « N PCLKA 32MHz
|
PLL Div /2 v > PCLKE Div /1 + —{PCLKB 32MHz |
)
PLL Mul x12 v > PCLKC Div /1 v —{PCLKC 32MHz \
]
PLL 48MHz . PCLKD Div /1 ~ | PCLKD 32MHz \
> BCLK Div /64 v —{BCLK 500kHz \
|
HOCO 32MHz v CLKOUT Disabled = No output v —{BCLKout OHz |
|LOCO 32768Hz | \> FCLK Div /2 v [ FCLK 16MHz \
|MOCO 8MHz |
|SUBCLK 32768Hz | \> UCLK Src: PLL v IUSBCLK 48MHz \

Summary |BSP | Clocks | Pins| Interrupts | Event Links| Stacks| Components

Figure 3-8 Clocks Configuration
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3.4 Add and configure MESH Stack

This section describes how to add / configure the MESH Stack into the MESH application. Click
configuration.xml in the project and add / configure the MESH Stack in the [Stacks] tab on the FSP
Configuration. The procedure about adding the MESH Stack is different for the BareMetal and the
FreeRTOS environment. Section 3.4.1 describes the procedure for the BareMetal environment. Section 3.4.2
describes the procedure for the FreeRTOS environment. The MESH Stack configuration is common to the
7BareMetal and the FreeRTOS environment. The configuration is described in detail in section 3.4.3.

3.4.1 Add MESH Stack in BareMetal environment

1. Click New Stack and add Networking>BLE Mesh Bearer Platform
(rm_ble_mesh_bearer_platform) to HAL/Common. This driver includes some peripheral driver. The
configuration for these peripherals are described in section 3.5.

2 +{sample_appl] FSP Configuration X % BLE Mesh Access (rm_ble_mesh_access) =0
% BLE Mesh Bearer (m_ble_mesh bearer)
Stacks Configuration BLE Mesh Bearer Platform (rm_ble_mesh_bearer_platform) Eararic o @t
& BLE Mesh Bearer Platform (rm_mesh_bearer platform)
Threads = 'n # BLE Mesh Config Client (rm_mesh_config_clt) ka N
—_ % BLE Mesh Config Server (rm_mesh_config_srv)
~ [daljcommon % BLE Mesh Lower Trans (rm_ble_mesh lower trans) Bl ?
& g_ioport /0 Port (r_ioport) % BLE Mesh Model Generic Admin Property Server (im_mesh_generic_admin_prop_srv) CoiimdIhElgEE
4 BLE Mesh Model Generic Battery Client (rm_mesh_generic_battery,_clt) A >
4 BLE Mesh Model Generic Battery Server (rm_mesh generic_battery srv) Bootloader D
@ BLE Mesh Model Generic Client Property Server (rm_mesh_generic_client_prop_srv) CapTouch e
% BLE Mesh Model Generic Default Transition Time Client (rm_mesh_generic_dtt_clt) Connectivity >
% BLE Mesh Model Generic Default Transition Time Server (rm_mesh_generic_dtt_sv) DsP >
% BLE Mesh Model Generic Level Client (m_mesh_generic_level _clt) Graphics >
% BLE Mesh Model Generic Level Server (rm_mesh_generic_level_srv) Input >
4 BLE Mesh Model Generic Location Client (rm_mesh_generic_loc_clt) Mornitoring >
% BLE Mesh Model Generic Location Server (m_mesh_generic_loc_srv) — S
% BLE Mesh Model Generic Manufacturer Property Server (rm_mesh_generic_mifr_prop_srv) T 5
% BLE Mesh Model Generic On Off Client (m_mesh_generic_on_off_cit)
4 BLE Mesh Model Generic On Off Server (rm_mesh_generic_on_off_srv) (e ¢
4 BLE Mesh Model Generic Power Level Client (rm_mesh_generic_pl_clt) ey 4
4 BLE Mesh Model Generic Power Level Server (rm_mesh_generic_pl_srv) Sensor >
% BLE Mesh Model Generic Power On Off Client (rm_mesh_generic_poo_clt) Storage >
Objects % BLE Mesh Model Generic Power On Off Server (rm_mesh_generic_poo_sr) System >
% BLE Mesh Model Generic Property Client (rm_mesh_generic_prop_clt) Timers >
% BLE Mesh Model Generic User Property Server (rm_mesh_generic_user_prop_srv) Transfer >
@ BLE Mesh Model Health Client (rm_mesh_health_cit) ) G
% BLE Mesh Model Health Server (rm_mesh_health_srv)
@ BLE Mesh Model Light Control Client (rm_mesh_light_cti_clt)
% BLE Mesh Model Light Control Server (rm_mesh_light_cti_srv)
% BLE Mesh Model Light HSL Client (rm_mesh_light_hsl_clt)
% BLE Mesh Model Light HSL Server (rm_rm_mesh_ight_hsl_srv)
4 BLE Mesh Model Light Lightness Client (rm_mesh_light_lightness_clt)
Summary | BSP Clocks Pins  Interrupts | Event Links | Stacks Components| %  BLE Mesh Model Light Lightness Controller Client (rm_mesh_light_Ic_clt)

Figure 3-9 Add Bluetooth Bearer

2. Click Add BLE Mesh OS Module box and select New->BLE Mesh OS on Baremetal
(rm_mesh_os_baremetal).

¥ *[sample_appl] FSP Configuration X =8

Stacks Configuration Generate Project Content

Threads =/ HAL/Common Stacks & New Stack >

~ g HAL/Common
4 g_ioport I/O Port (r_ioport)
& BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

% BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

% BLE Mesh Bearer (rm_ble_mesh bearer)

% BLE Mesh (rm_ble_mesh)

T T T t
. Add BLE Mesh OS %9 Add BLE Mesh Timer | | %% Add Timer Driver & g_flash0 Flash % BLE Driver (r_ble_ext
Module Module (r_flash_Ip)
Objects
@ @
New > & BLEMeshOS onBaremetal (rm_mesh os baremetal) e E—
T | & BLE Mesh OS on FreeRTOS (rm_mesh_os freertos) @ g flash1 Flash
(r_flash_Ip)
@
< >

Summary [BSP | Clocks|Pins| Interrupts | Event Links| © Stacks| Components

Figure 3-10 Add OS
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3. Click Add BLE Mesh Timer Module box and select New—>BLE Mesh Timer on Baremetal
(rm_mesh_timer_baremetal).

% *[sample_appl] FSP Configuration X

=0

Stacks Configuration

Threads B

~ g HAL/Common
4 g_ioport I/O Port (r_ioport)
8 BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

Objects

HAL/Common Stacks

Generate Project Content

€] New Stack >

% BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

% BLE Mesh Bearer (rm_ble_mesh bearer)

% BLE Mesh (rm_ble_mesh)

T

4 BLE Mesh OS on
Baremetal
(rm_mesh_os baremet
al)

% Add BLE Mesh Timer
Module

%3 Add Timer Driver

> % BLE Mesh Timer on Baremetal (rm_mesh_timer_baremetal)
BLE Mesh Timer on FreeRTOS (rm_mesh_timer_freertos)

t
& g_flashO Flash
(r_flash_Ip)

% BLE Driver (r_ble_ext

@ @

Figure 3-11 Add Timer
4. Click Add BLE Network Driver box and select New—->BLE Driver (r_ble_extended).

¥ *{new] FSP Configuration
Stacks Configuration

Threads %) Remove -l
~ g HAL/Common

4 g_ioport I/0 Port (r_ioport)
& BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

Objects

Summary|BSP | Clocks | Pins Interrupts | Event Links| © Stacks|Components

BLE Mesh Bearer Platform (rm_mesh_bearer_platform) Stacks

Generate Project Content

¢ New Stack >

& BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

®

% BLE Mesh Bearer (rm_ble_mesh bearer)

®

% BLE Mesh (rm_ble_mesh)

®

T
“ Add BLE Network
Driver

% BLE Driver (r_ble_balance) | New >
% BLE Driver (r_ble_compact)
& BLE Driver (r_ble_extended)

% BLE Mesh OS on % BLE Mesh Timer on

Baremetal Baremetal
(rm_mesh_os_baremet (rm_mesh_timer_bare
® al) ® metal)

&1 Add Timer Driver

T
& g flash0 Flash

<

Figure 3-12 Add Bluetooth LE Stack
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5. Click New Stack and add the required model for your mesh application to HAL/Common. For example,
if you want to use the Generic On Off Server model, choose Networking->BLE Mesh Model Generc

On Off Server.

% [sample_appl] FSP Configuration X

Stacks Configuration

~ g HAL/Common
4 g_ioport /O Port (r_ioport)
& BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

Objects

Summary BSP | Clocks|Pins | Interrupts [ Event Links| © Stacks| Components|

Threads S H

<

BLE Mesh Bearer Platform (m_ble_mesh_bearer_platform)
@ BLE Mesh Config Client (rm_mesh_config_clt)

% BLE Mesh Config Server (rm_mesh_config_srv)

% BLE Mesh Lower Trans (rm_ble_mesh_lower _trans)

4 BLE Mesh Model Generic Admin Property Server (rm_mesh_generic_admin_prop_srv)
% BLE Mesh Model Generic Battery Client (rm_mesh_generic_battery_clt)
% BLE Mesh Model Generic Battery Server (rm_mesh_generic_battery_srv)
% BLE Mesh Model Generic Client Property Server (rm_mesh_generic_client_prop_srv)
% BLE Mesh Model Generic Default Transition Time Client (rm_mesh_generic_dtt_clt)
% BLE Mesh Model Generic Default Transition Time Server (rm_mesh_generic_dtt_srv)
% BLE Mesh Model Generic Level Client (m_mesh_generic_level_cl)

% BLE Mesh Model Generic Level Server (rm_mesh_generic_level_srv)

% BLE Mesh Model Generic Location Client (m_mesh_generic_loc_clt)
% BLE Mesh Model Generic Location Server (rm_mesh_generic_loc_srv)
4 BLE Mesh Model Generic Manufacturer Property Server (rm_mesh_generic_mifr_prop_srv)
% BLE Mesh Model Generic On Off Client (m_mesh_generic_on_off_cit)
% BLE Mesh Model Generic On Off Server (rm_mesh_generic_on_off srv)
% BLE Mesh Model Generic Power Level Client (rm_mesh_generic_pl_clt)
% BLE Mesh Model Generic Power Level Server (rm_mesh_generic_pl_srv)
% BLE Mesh Model Generic Power On Off Client (rm_mesh_generic_poo_clt)

% BLE Mesh Model Generic Power On Off Server (rm_mesh_generic_poo_srv)

% BLE Mesh Model Generic Property Client (rm_mesh_generic_prop_clt)

% BLE Mesh Model Generic User Property Server (rm_mesh_generic_user_prop_srv)
@ BLE Mesh Model Health Client (rm_mesh_health_cit)

% BLE Mesh Model Health Server (rm_mesh_health_srv)

% BLE Mesh Model Light Control Client (rm_mesh_light_ctl_clt)

% BLE Mesh Model Light Control Server (rm_mesh light_ctl_srv)

% BLE Mesh Model Light HSL Client (rm_mesh_light_hsl_clt)

% BLE Mesh Model Light HSL Server (rm_rm_mesh_ight_hsl_srv)

4 BLE Mesh Model Light Lightness Client (m_mesh_light_lightness_clt)

% BLE Mesh Model Light Lightness Controller Client (rm_mesh,_light_Ic_clt)

% BLE Mesh Model Light Lightness Controller Server (rm_rm_mesh_light_Ic_srv)

% BLE Mesh Model Light Lightness Server (rm_mesh light.lightness_srv)

% BLE Mesh Model Liht XYL Client (rm mesh liaht xvI cit)

Figure 3-13. Add Mesh Model

=]

Generate Project Content

rack +

Analog

i Ramove

Artificial Intelligence

Audio
Bootloader
CapTouch
Connectivity
DsP
Graphics
Input
Monitoring
Motor
Networking
Power
Security
Sensor
Storage
System
Timers
Transfer

Search.

EY

@

(r_flash_Ip)

~

NOTE: If you are adding a second or subsequent model to the same element, click the Add BLE Mesh
Access Module box and select Use>g_rm_ble_access0 BLE Mesh Access (rm_ble_mesh_access).

¥ *[new] FSP Configuration

a

Threads %/Remove - BLE Mesh Config Server (rm_mesh_config_srv) Stacks

~ g HAL/Common
4 g_ioport I/O Port (r_ioport)
& BLE Mesh Bearer Platform (rm_mesh_bearer_platform)
# BLE Mesh Config Client (rm_mesh_config clt)
< BLE Mesh Config Server (rm_mesh_config_srv)

Objects

Summary [BSP | Clocks Pins| Interrupts | Event Links| @ Stacks| Components

Generate Project Content

) New Stack >
# BLE Mesh Config
Server
(rm_mesh_config_srv)
[©]
x
Add BLE Mesh Access
Module
New > |
Use > ¥ g.rm_ble mesh access0 BLE Mesh Access (m_ble mesh access) |
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3.4.2 Add MESH Stack in FreeRTOS environment

1. Click New Thread on the Threads area and add a New Thread. In this example, the New Thread is
named BLE CORE_TASK.

& *[sample_appl] FSP Configuration &2 =
Stacks Conflguratlon Generate Project Content
Threads 4| New Thread #]Remove =] BLE_CORE TASK Stacks 4] New Stack >
~ & HAL/Comman i . Add stacks to the selected thread by using the "New Stack > toolbar button (above), or by
3 g_ioport I/O Port (r_ioport) vy pasting here from the clipboard.

4 FreeRTOS Port (rm_freertos_port)
# BLE_CORE_TASK

Objects %] New Object >

Summary | BSP |Clocks | Pins | Interrupts  Event Links | Stacks | Components

BLE CORE TASK

Settings Property Value
“aress
Symbol ble_core_task
Name BLE CORE TASK
Stack size (bytes) 1024
Priority 1
Thread Context NULL
Memory Allocation Static
Allocate Secure Context Enable

Symbol used for generated function and file naming

Figure 3-14 Add BLE_CORE_TASK

2. Change Stack size to 0x3000[bytes]. Change Priority to 2.

BLE_CORE_TASK
Settings  Property Value
~ Thread
Symbol ble_core_task
Name BLE_CORE TASK
Stack size (bytes) 0x3000
PriOLiTV 2
Thread Context NULL
Memory Allocation Static
Allocate Secure Context Enable

MNumber bytes in the stack memor...st be an integer multiple of 8.

Figure 3-15 Stack size and Priority of BLE_CORE_TASK
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3. Change FreeRTOS configurations as the following in BLE_ CORE_TASK Properties tab.

Table 3-2 FreeRTOS Configuration and Macro

Configuration and Macro Changed Value Default Value
Common > General > Minimal Stack Size 1024 128
(configMINIMAL_STACK_SIZE)
Common > General > Use Mutexes Enabled Disabled
(configUSE_MUTEXES)
Common > General > Use Recursive Mutexes Enabled Disabled
(configUSE_RECURSIVE_MUTEXES)
Common > General > Enable Backward Compatibility Enabled Disabled
(configENABLE_BACKWARD_COMPATIBILITY)
Common > Memory Allocation > Support Dynamic Allocation Enabled Disabled
(configSUPPORT_DYNAMIC_ALLOCATION)
Common > Memory Allocation > Total Heap Size 11264 0
(configTOTAL_HEAP_SIZE)
Common > Timers > Timer Queue Length 32 10
(configTIMER_QUEUE_LENGTH)
Common > Optional Functions > xTimerPendFunctoinCall() Function | Enabled Disabled
(INCLUDE_xTimerPendFunctionCall)

4. Click New Stack and add Networking->BLE Mesh Bearer Platform
(rm_ble_mesh_bearer_platform) to BLE_CORE_TASK. This driver includes some peripheral driver.
The configuration for these peripherals are described in section 3.5.

% AWS HTTPS Client (Deprecated) =]
) % AWS HTTPS Wrapper )
Stacks Confi ¢ Aws MQTT Client (Deprecated) Generate Project Content
4 AWS MQTT Demo (Deprecated)
Threads . & AWS MQTT Wrapper
URTyvm— @ AWS Secure Sockets on WiFi A"é'?? ’
~ = HAL/Comi 4 AWS Taskpool Artificial Intelligence >
f G.19PO 4 AWS Transport Interface on Secure Sockets Audio >
# FreeRT( 4 £ Abstraction (rm_ble_abs) Bootloader >
i BLE CORE 4 BLE Mesh (rm_ble_mesh) CapTouch 4
@ BLE Mesh Access (rm_ble_mesh_access) Connectivity >
@  BLE Mesh Bearer (rm_ble_mesh_bearer) DSP >
< BLE Mesh Bearer Platform {rm_ble_mesh_bearer_platform) Graphics N
4 BLE Mesh Lower Trans (rm_ble_mesh_lower_trans) (e 5
4  BLE Mesh Model Generic Admin Property Server (rm_mesh_generic_admin_prop_srv) o
“  BLE Mesh Model Generic Battery Client (rm_mesh_generic_battery _clt) Rlersenng ’
% BLE Mesh Model Generic Battery Server (rm_mesh_generic_battery_srv) iMooy ’
@  BLE Mesh Model Generic Client Property Server (rm_mesh_generic_client_prop_srv) Networking ’
%  BLE Mesh Model Generic Default Transition Time Client (rm_mesh_generic_dtt_clt) Power 2
% BLE Mesh Madel Generic Default Transition Time Server (rm_mesh_generic_dtt_srv) RTOS >
4  BLE Mesh Model Generic Level Client (rm_mesh_generic_level_clt) Security >
@  BLE Mesh Model Generic Level Server (rm_mesh_generic_level_srv) Sensor >
@ BLE Mesh Model Generic Location Client (rm_mesh_generic_loc_clt) Storage >
%  BLE Mesh Model Generic Location Server (rm_mesh_generic_loc_srv) System 5
% BLE Mesh Model Generic Manufacturer Property Server (rm_mesh_generic_mfr_prop_srv) TS 5
4 BLE Mesh Model Generic On Off Client (rm_mesh_generic_on_off _clt}
Objects @ BLE Mesh Model Generic On Off Server (rm_mesh_generic_on_off_srv) [Uasiey ?
%  BLE Mesh Model Generic Power Level Client (rm_mesh_generic_pl_clt) 4 Search..
% BLE Mesh Model Generic Power Level Server (rm_mesh_generic_pl_srv)
%  BLE Mesh Model Generic Power On Off Client (rm_mesh_generic_poo_clt)
4 BLE Mesh Model Generic Power On Off Server (rm_mesh_generic_poo_srv)
4  BLE Mesh Model Generic Property Client (rm_mesh_generic_prop_clt)
% BLE Mesh Model Generic User Property Server (rm_mesh_generic_user_prop_srv}
@ BLE Mesh Model Health Client (rm_mesh_health_clt)
% BLE Mesh Model Health Server (rm_mesh_health_srv)
L # BLE Mesh Model Light Control Client (rm_mesh_light_ctl_clt)
Summary BSP|Clt 4  BLE Mesh Model Light Control Server (rm_mesh_light_ctl_srv)

Figure 3-16 Add Bluetooth Bearer
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(rm_mesh_os_freertos).

Click Add BLE Mesh OS Module box and select New—=>BLE Mesh OS on FreeRTOS

% *[sample_freertos] FSP Configuration %

Stacks Configuration

=8

Threads €] New Thread #|Remove I

~ g HAL/Common

4 g_ioport /O Port (r_ioport)

4 FreeRTOS Port (rm_freertos_port)
~ g BLE_CORE_TASK

@ BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

BLE_CORE TASK Stacks

4 New Stack >

Generate Project Content

4 BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

4 BLE Mesh Bearer (rm_ble_mesh_bearer)

=3

Objects %] New Object >

4 BLE Mesh (rm_ble_mesh}

;
% Add BLE Mesh OS

Module

ry

T T T
= - = - - p

! ‘ & Add BLE Mesh Timer @7 Add Timer Driver 2 g_flashO Flash

7.

%1 Add BLE Ne
Module (r_flash_Ip) Driver
New > 4 BLE Mesh OS on Baremetal (rm,mesh,os,balsms;al) i
< % BLE Mesh OS on FreeRTOS (rm_mesh_os_freertos) | =
Summary |BSP |Clocks | Pins | Interrupts | Event Links | @ Stacks| Components
Figure 3-17 Add OS

Click Add BLE Mesh Timer Module box and select New->BLE Mesh Timer on FreeRTOS

(rm_mesh_timer_freertos).
=5
Stacks Configuration

Threads 4] New Thread ] Remove =

~ & HAL/Common

]
4 g_ioport I/0 Port {r_ioport) .

BLE_CORE_TASK Stacks

4] New Stack >

Generate Project Content

& FreeRTOS Port (rm_freertos_port)
~ g BLE_CORE_TASK

@ BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

LE Mesh Bearer Platform (rm_mesh_bearer_platform)

# BLE Mesh Bearer (rm_ble_mesh_bearer}

T
4 BLE Mesh (rm_ble_mesh)

<

Summary | BSP |Clacks | Pins | Interrupts | Event Links | @ Stacks| Components

e —

Objects %] New Object > ; . = ; :
4 BLE Mesh OS on % Add BLE Mesh Timer | | 57 Add Timer Driver @ g_flashO Flash %9 Add BLE Nei
FreeRTOS Module (r_flash_Ip) Driver
(rm_mesh_os_freertos)
New 5> & BLE Mesh Timer on Baremetal (rm_mesh_timer_baremetal)

BLE Mesh Timer on FreeRTOS (rm_mesh_timer_freertos)

Figure 3-18 Add Timer
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7. Click Add BLE Network Driver box and select New—->BLE Driver (r_ble_extended_freertos).
=5

Stacks Configuration

Generate Project Content

Threads %|New Thread #|Remove =  BLE CORE_TASK Stacks & New Stack >

~ & HAL/Common

4% g_ioport I/O Part (r_ioport)

4 FreeRTOS Port (rm_freertos_port)
~ g BLE_CORE_TASK

@ BLE Mesh Bearer Platform (rm_mesh_bearer_platform) A

sh Bearer Platform (rm_mesh_bearer_platform)

sh Bearer (rm_ble_mesh_bearer)

sh (rm_ble_mesh)

Objects +] New Object > . ; s ; ;
sh OS on & BLE Mesh Timer on %1 Add Timer Driver & g_flash0 Flash % Add BLE Network
oS FreeRTOS (r_flash_lp) Driver
1sh_os_freertos) (rm_mesh_timer_freert
os) %  BLE Driver (r_ble_extended) New b3
<% BLE Driver (r_ble_extended_freertos)
< >

Summary BSP Clocks | Pins Interrupts |Event Links & Stacks| Components

Figure 3-19 Add Bluetooth LE Stack

8. Click New Stack and add the required model for your mesh application to BLE_CORE_TASK. For
example, if you want to use Generic On Off Server model, choose Networking>BLE Mesh Model
Generic On Off Server.

% AWS HTTPS Client (Deprecated) =7
4 AWS HTTPS Wrapper
Stacks Configuration % AWS MQTT Client (Deprecated) ®
Generate Project Content
4 AWS MQTT Demo (Deprecated)
Threads ] New Thread &) Remove =  BLECOF ¥ AWSMQTT Wrapper
= % AWS Secure Sockets on WiFi Analog 2
~ & HAL/Common gL & AWS Taskpool Artificial Intelligence >
i g_loport |/Q Port (r_ioport) % AWS Transport Interface on Secure Sockets Audio >
 FreeRTOS Part (rm freertos port) % BLE Abstraction (rm_ble_abs) Bootloader >
4 FreeRTOS Heap 4 4 BLE Mesh Access (rm_ble_mesh_access) CapTouch 5
~ @ BLE_CORE_TASK C— & BLE Mesh Lower Trans (rm_ble_mesh_lower_trans) EoNEEE R 5
4 BLE Mesh Bearer Platform (rm_ble_mesh_bearer_platform) 42 g # BLE Mesh Model Generic Admin Property Server (rm_mesh generic_admin_prop_srv) e )
#  BLE Mesh Model Generic Battery Client (rm_mesh_generic_battery_clt) .
4 BLE Mesh Model Generic Battery Server (rm_mesh_generic_battery_srv) cEphic ’
# BLE Mesh Model Generic Client Property Server (rm_mesh_generic_client_prop_srv) IHDUT ’
" % BLE Mesh Model Generic Default Transition Time Client (rm_mesh_generic_dtt_clt) Monitoring ’
4 Bu 4 BLE Mesh Model Generic Default Transition Time Server (rm_mesh_generic_dtt_srv) Motor &
@ BLE Mesh Model Generic Level Client (rm_mesh_generic_level_clt) Networking >
@ BLE Mesh Model Generic Level Server (rm_mesh_generic_level_srv) Power >
#  BLE Mesh Model Generic Location Client (rm_mesh_generic_loc_clt) RTOS >
[ 4 BLE Mesh Model Generic Location Server (rm_mesh_generic_loc_sn) Security >
gL % BLE Mesh Model Generic Manufacturer Property Server (rm_mesh_generic_mfr_prop_srv) Sensor >
fre # BLE Mesh Model Generic On Off Client (rm_mesh_generic_on_off clt) Storage S
(rmr 4+ BLE Mesh Model Generic On Off Server (rm_mesh_generic_on_off_srv) System 5
@ BLE Mesh Model Generic Power Level Client (rm_mesh_generic_pl_clt) N
[ 4 BLE Mesh Model Generic Power Level Server (rm_mesh_generic_pl_srv) GRS ’
Objects = New Object > #  BLE Mesh Model Generic Power On Off Client (rm_mesh_generic_poo_clt) Transfer ’
4 BLE Mesh Model Generic Power On Off Server (rm_mesh_generic_poo_srnv) 4" Search.
4 BLE Mesh Model Generic Property Client (rm_mesh_generic_prop_clt)
@ BLE Mesh Model Generic User Property Server (rm_mesh_generic_user_prop_srv) @
4 BLE Mesh Model Health Client (rm_mesh_health_clt)
%  BLE Mesh Model Health Server (rm_mesh_health_srv)
4 BLE Mesh Model Light Control Client (rm_mesh_light_ctl_clt)
% BLE Mesh Model Light Control Server (rm_mesh_light_ctl_srv)
& BLE Mesh Model Light HSL Client (rm_mesh_light_hsl_clt)
8 & BLE Mesh Model Light HSL Server (rm_mesh_light_hs|_srv) &
Summary |BSP |Clocks | Pins | Interrupts | Event Links | Stacks| Components @  BLE Mesh Model Light Lightness Client (rm_mesh_light_lightness_clt)

Figure 3-20 Add Mesh Model

NOTE: If you are adding a second or subsequent model to the same element, click the Add BLE Mesh
Access Module box and select Use>g_rm_ble_access0 BLE Mesh Access (rm_ble_mesh_access).
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9. Add RTOS->FreeRTOS Heap4 to HAL/Common.

£ *[sample_appl] FSP Configuration % =8
Stacks co“f'g“rat'on Generate Project Content
Threads <] New Thread =l HAL/Common Stacks ] Mawns Rtanls
i HAL/C Analog >
v o LSomman 4 g ioport IfO Port % FreeRTOS Port Artificial Intelligence >
4 g_ioport I/0 Port (r_ioport) .
s (r_ioport} (rm_freertos_port) Audio >
4 FreeRTOS Port (rm_freertos_port) Bootioad: 5
+ g BLE_CORE_TASK ® ® CUDTDB her X
4% BLE Mesh Bearer Platform (rm_ble_mesh_bearer_platform) = ou(- .
Connectivity >
DsP >
Graphics 3
Input >
Monitering >
Motor >
Networking >
Power >
Objects £ New Object > :9 FreeRTOS Buffer Allocation 2 RTOS >
% FreeRTOS Heap 1 Security >
4 FreeRTOS Heap 2 Sensor >
% FreeRTOS Heap 3 Storage 5
#+  FreeRTOS Heap 4 S
ystem >
4 FreeRTOS Heap 5 Y
Timers >
Transfer >
Summary | BSP | Clocks | Pins | Interrupts | Event Links| @ Stacks| Components 4 Search..

Figure 3-21 Add Heap4
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3.4.3 Configure Mesh Stack

This section describes the configurations required for the e BLE Mesh Network Middleware on rm_ble_mesh

module.

Select [BLE Mesh Bearer Platform (rm_mesh_bearer_platform)] on the [Stacks] tab and change the
properties as shown in Table 3-3. For details on each property value, refer to “Renesas Flexible Software

Package (FSP) User's Manual (R11UMO0155)”.

Table 3-3 Mesh Stack Configuration and Macro

Configuration and Macro

Default Value

Value for Mesh

(MESH_BEARER_PLATFORM_CFG_RF_SYNC_SET_MAXIMUM)

Maximum number of connections 7 1
(MESH_BEARER_PLATFORM_CFG_RF_CONNECTION_MAXIMUM)

Maximum advertising data length 1650 31
(MESH_BEARER_PLATFORM_CFG_RF_ADVERTISING_DATA_MAXIMUM)

Maximum advertising set number 4 1
(MESH_BEARER_PLATFORM_CFG_RF_ADVERTISING_SET_MAXIMUM)

Maximum periodic sync set number 2 1

Set "1" to [Maximum number of connections], "31" to [Maximum advertising data length], "1" to [Maximum

advertising set number], "1" to [Maximum periodic sync set number] respectively.
&Debug ' Search [i] Stack Analysis Memory Usage

BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

Settings  Property Value
~ Common

Debug Public Address FF:FFFF:50:90:74
Debug Random Address FF.FF.FF.FF.FF.FF

l_ Maximum number of connections 1

o WaXimum connection data 1engi 5T

Maximum advertising data length 31
Maximum advertising set number 1
Maximum periodic sync set number. 1
Store Security Data Disable
Data Flash Block for Security Data 0
Remote Device Bonding Number 7
Connection Event Start Notify Disable
Connection Event Close Notify Disable
Advertising Event Start Notify Disable
Advertising Event Close Notify Disable
Scanning Event Start Notify Disable
Scanning Event Close Notify Disable
Initiating Event Start Notify Disable
Initiating Event Close Notify Disable
RF Deep Sleep Start Notify Disable
RF Deep Sleep Wakeup Motify Disable

Bluetooth dedicated clock

6

Maximum number of connections.

Figure 3-22 Mesh Stack Configuration (1)

NOTE: Set the same values in the properties of the BLE Driver box as well.
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Select [BLE Mesh (rm_ble_mesh)] on the [Stacks] tab and change the properties as shown in Table 3-4. For
details on each property value, refer to “Renesas Flexible Software Package (FSP) User's Manual

(R11UMO0155)".

Table 3-4 Mesh Stack Configuration
Configuration

Storage->Block Number

Default Value

1

Value for Mesh
6

Memory Pool->Memory Pool Size

The number of Data Flash Blocks used for storing mesh information
MIN: 1
MAX: 8

0x4000

0x3000

Set "6" to [Block number], "0x3000" to [Memory pool size].

’i& Debug 4 Search [&] Stack Analysis @ Memory Usage

BLE Mesh (rm_ble _mesh)

Settings Property Value
Common
~ Module BLE Mesh (rm_ble_mesh)
General

~ Storage
Block Number 6
~ Memory Pool
Memory Pool S_ize D_xSDDD

Logging

Channel Number

Network Interface Number
Provisioning Interface Number
Network Cache Size

MNetwork Sequence Number Cache Size
Maximum Number of Subnet
Maximum Number of Device Key
Proxy Filter List Size

Maximum Number of LPN
Reassembled Cache Size 8
Maximum Number of Segmentation anc 8
Maximum Number of Friend Message Q 15
Maximum Number of Friend Subscriptio 8

R N A=)
[SaE=1

Maximum Number of Element 4

Block number.

Figure 3-23 Mesh Stack Configuration (2)
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3.4.4 Oher Mesh Stack configuration

The Mesh Stack has parameters that can be changed depends on each mesh network scale and each
requirement for node. These parameters can be set with FSP Configuration and are reflected in

"common_data.c" when generating code.

Table 3-5 BLE Mesh (rm_ble_mesh) Configuration and Variable name

Configuration and Variable name Description

Bearer->Network Interface Number
(network_interfaces_num)
*Default: 2

The number of bearers used for Mesh Network

MIN: 1

MAX: (1 +

MESH_BEARER PLATFORM_CFG_RF_CONNECTIO
N_MAXIMUM)

First bearer is ADV bearer and subsequent bearers are
GATT bearers which can establish connections
concurrently. When this configuration is set to 1, only
ADV bearer can be used.

Bearer-> Provisioning Interface Number
(provisioning_interfaces_num)
*Default: 2

The number of bearers used for Provisioning
MIN: 1
MAX: 2

When this configuration is set to 1, only PB-ADV bearer
can be used. When this configuration is set to 2, PB-
ADV bearer and one PB-GATT bearer can be used.

Provisioning=>Unprovisioned Device Beacon Timeout in
Milliseconds

(unprov_device_beacon_timeout)

*Default: 200

Transmission interval of Unprovisioned Device Beacon
[msec]
MIN: 20

When only PB-ADV is used, Unprovisioned Device
Beacon is transmitted at the intervals of this
configuration. When only PB-GATT is used,
Connectable Advertising PDU is transmitted at the
intervals of this configuration. When both PB-ADV and
PB-GATT are used, Unprovisioned Device Beacon and
Connectable Advertising PDU are transmitted
alternately at the intervals of this configuration.

Network—>Network Cache Size
(network_cache_size)
*Default: 10

The maximum number of nodes that Network Message
Cache can store
MIN: 2

If message from new node is received when Network
Message Cache stores cache information for the
maximum number of nodes, cache information for the
oldest node will be removed.

Network—> Network Sequence Number Cache Size
(network_sequence_num_cache_size)
*Default: 32

The number of SEQ number that Network Message
Cache can store for each node
MIN: 32

Network—>Maximum Number of Subnet
(maximum_subnets)

Maximum number of subnet information such as
Network Key and NID

*Default: 4

*Default: 4 MIN: 1
Network—->Maximum Number of Device Key Maximum number of Device Key
(maximum_device_keys) MIN: 1

When Configuration Client Model is not used, it is
enough to set this configuration to 1.
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Network—> Proxy Filter List Size
(proxy_filter_list_size)
*Default: 2

Maximum number of addresses that can be added to
each Proxy List
MIN: 1

Network—> Network Sequence Number Block Size
(net_sequence_number_block_size)
*Default: 2048

Distance between SEQ number for writing to Data
Flash memory
MIN: 1

SEQ number will be saved to Data Flash at the
distance of this configuration. When MCU is reset, SEQ
number resumes from the next distance.

e.g.) When this configuration is 2048, SEQ number is
written to Data Flash every time SEQ number reaches
a multiple of 2048 such as 2048 and 4096. If MCU is
reset when SEQ number is 3000, SEQ number
resumes from 4096.

The shorter this configuration is, the more frequently
SEQ number is written to Data Flash. The longer this
configuration is, the bigger SEQ number is skipped
after resetting MCU.

Network—>Network Transmit Count for Network Packets
(net_tx_count)
*Default: 1

Default value of Network Transmit Count state
MIN: 0
MAX: 7

Network—> Network Interval Steps for Network Packets
(net_tx_interval_steps)
*Default: 4

Default value of Network Transmit Interval Steps state
MIN: O
MAX: 31

Network—>Network Transmit Count for Relayed Packets
(net_relay_tx_count)
*Default: 0

Default value of Relay Retransmit Count state
MIN: O
MAX: 7

Network->Network Interval Steps for Relayed Packets
(net_relay_tx_interval_steps)
*Default: 9

Default value of Relay Retransmit Interval Steps state
MIN: 0
MAX: 31

Network—->Proxy ADV Network ID Timeout for Each Subnet
in Milliseconds

(proxy_subnet_netid_adv_timeout)

*Default: 100

Transmission interval of Proxy Advertisement with
Network ID [msec]
MIN: 20

Network—>Proxy ADV Node Identity Timeout for Each
Subnet in Milliseconds
(proxy_subnet_nodeid_adv_timeout)

*Default: 300

Transmission interval of Proxy Advertisement with
Node Identity [msec]
MIN: 20

Network—->Proxy ADV Node Identity Overall Time Period in
Milliseconds

(proxy_nodeid_adv_timeout)

*Default: 60

Transmission period of Proxy Advertisement with Node
Identity [sec]
MIN: 1

Network->Maximum Number of Queued Messages for
Transmission

(net_tx_queue_size)

*Default: 64

Size of transmission queue for Network PDUs
MIN: 2

Transport->Maximum Number of LPN
(maximum_Ipn)

Maximum number of Low Power Nodes that Friend
Node can establish Friendship with

*Default: 1 MIN: 1
Transport->Replay Protection Cache Size Size of Replay Protection Cache
(replay_cache_size) MIN: 2

*Default: 10

Transport->Reassembled Cache Size

Size of reception message cache of Segmentation and

(reassembled_cache_size) Reassembly (SAR)

*Default: 8 MIN: 2
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Transport->Friend Poll Retry Count
(frnd_poll_retry_count)
*Default: 10

The number of times to retry Friend Poll message when
Low Power Node does not receive Friend Update
message

MIN: 1

Transport->Maximum Number of Segmentation and
Reassembly

(maximum_Itrn_sar_context)

*Default: 8

The number of contexts of Segmentation and
Reassembly (SAR) mechanism used for transmitting
and receiving Segmented Message

MIN: 2

Transport->Lower Transport Segment Transmission
Timeout in Milliseconds

(Itrn_rtx_timeout)

*Default: 300

Retransmission interval of segmented message [msec]
MIN: 200

Transport->Lower Transport Segment Re-Transmission
Count

(Itrn_rtx_count)

*Default: 2

The number of times to retransmit segmented message
MIN: 2
MAX: 255

Transport->Lower Transport Acknowledgement Timeout in
Milliseconds

(Itrn_ack_timeout)

*Default: 200

Transmission interval of Segmented Acknowledgement
message [msec]
MIN: 200

Transport->Lower Transport Incomplete Timeout in
Milliseconds

(Itrn_incomplete_timeout)

*Default: 20

Cancel timeout time of receiving segmented message
[sec]
MIN: 10

Transport->Friendship Receive Window
(frnd_receive_window)
*Default: 100

Reception windows size of Low Power Node [msec]
MIN: 100
MAX: 255

Transport->Maximum Number of Friend Message Queue
(maximum_friend_message_queue)
*Default: 15

Size of Message Queues for each Low Power Node
MIN: 2

Transport->Maximum Number of Friend Subscription List
(maximum_friend_subscription_list)
*Default: 8

Maximum number of Friend Subscription Lists for each
Low Power Node
MIN: 1

Transport->Friend Clear Confirmation Timeout in
Milliseconds

(Ipn_clear_retry_timeout_initial)

*Default: 1000

Retransmission interval of Friend Clear message when
Low Power Node does not receive Friend Clear
Confirmation message

MIN: 1000

Transport->Friend Clear Retry Count
(Ipn_clear_retry_count)

The number of times to retry Friend Clear message
when Low Power Node does not receive Friend Clear

*Default: 5 Confirmation message

MIN: 1
Transport->Friendship Retry Timeout in Milliseconds Transmission period of Friend Request message
(trn_frndreq_retry_timeout) [msec]
*Default: 1200 MIN: 1100
Access>Maximum Number of Element Maximum number of Elements
(maximum_access_element_num) MIN: 1

*Default: 4

Access—~>Maximum Number of Model
(maximum_access_model_num)
*Default: 60

Maximum number of Models
MIN: 1

Access—~>Maximum Number of Application
(maximum_application)
*Default: 8

Maximum number of Application Keys
MIN: 1

Access—~>Maximum Number of Virtual Address

Maximum number of Virtual Address

(maximum_virtual_address) MIN: 1

*Default: 8
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Access—~>Maximum Number of Non-Virtual Address
(maximum_non_virtual_address)
*Default: 8

Maximum number of Non-virtual Address (Unicast
Address or Group Address)
MIN: 1

Access~>Maximum Number of Transition Timers
(max_num_transition_timers)
*Default: 5

The number of State Transition Timers for models
MIN: 1

Access—~>Maximum Number of Periodic Step Timers
(max_num_periodic_step_timers)
*Default: 5

The number of Periodic Publication Timers for models
MIN: 1

Foundation-> Config Server Secure Network Beacon
Interval

(config_server_snb_timeout)

*Default: 10

Transmission Interval of Secure Network Beacon [sec]
MIN: 10
MAX: 600

Foundation>Maximum Number of Health Server Instance
(maximum_health_server_num)
*Default: 2

Maximum number of Health Server Model
MIN: 1

Model->Maximum Number of Light Lightness Controller
Server Instance

(maximum_light_Ic_server_num)

*Default: 1

Maximum number of Light Lightness Controller Server
Model
MIN: 1

ID->Company ID

Company ID registered with Bluetooth SIG

(default_company_id) MIN: 0x0000

*Default: 0x0036 MAX: OxFFFF

ID->Product ID Product ID assigned by vendor
(default_product_id) MIN: 0x0000

*Default: 0x0001 MAX: OxFFFF

ID->Vendor ID Product Version ID assigned by vendor
(default_vendor_id) MIN: 0x0000

*Default: 0x0100 MAX: OxFFFF

logging—>Packet Bitfield
(p_logging_cfg->packet_bitfield)
*Default: 0

Get packet-related log

logging—>Module Info Bitfield
(p_logging_cfg->module_info_bitfield)
*Default: 0

Get module-related log

logging—> Generic Log Bitfield
(p_logging_cfg->generic_log_bitfield)
*Default: 0

Get generic log

logging—>function

(p_logging_cfg->p_logging_func)
*Default: logging_function

Callback when logging

Table 3-6 BLE Mesh Provision (rm_ble_mesh_provision) Configuration and Variable name

Configuration and Variable name Description

Provision Capabilities=>Number of Elements
(num_elements)
*Default: 1

For detail, refer to Mesh Profile Specification.

Provision Capabilities> Supported Algorithms
(supported_algorithms)
*Default: 1

For detail, refer to Mesh Profile Specification.

Provision Capabilities—>Public Key Type
(supported_pubkey)
*Default: 1

For detail, refer to Mesh Profile Specification.

Provision Capabilities—> Static OOB Type
(supported_soob)
*Default: 1

For detail, refer to Mesh Profile Specification.
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Provision Capabilities> Output OOB Action
(output_oob.action)
*Default: Ox1F

For detail, refer to Mesh Profile Specification.

Provision Capabilities=> Output OOB Size
(output_oob.size)
*Default: 0x08

For detail, refer to Mesh Profile Specification.

Provision Capabilities=>Input OOB Action
(input_oob.action)
*Default: OxOF

For detail, refer to Mesh Profile Specification.

Provision Capabilities=>Input OOB Size
(input_oob.size)
*Default: 0x04

For detail, refer to Mesh Profile Specification.

Provision Callback
(p_callback)
*Default: NULL

Callback from Provisioning process

Table 3-7 BLE Mesh Network (rm_ble_mesh_network) Configuration and Variable name

Configuration and Variable name

Description

Callback
(p_callback)
*Default: 1

Callback from Network process

Table 3-8 BLE Mesh Upper Trans (rm_ble_mesh_upper_trans) Configuration and Variable name

Description

Configuration and Variable name

Callback
(p_callback)
*Default: NULL

Callback Upper Transport process

Table 3-9 BLE Mesh Access (rm_ble_mesh_access) Configuration and Variable name

Configuration and Variable name Description

Location Descriptor
(p_element_descriptor->loc)
*Default: 0

where the element is placed

Element Number
(element_number)
*Default: 0

The number to identify the element

Table 3-10 BLE Mesh Bearer Platform (rm_mesh_bearer_platform) Configuration and Variable name

Configuration and Variable name Description

Device Address Type BD address type

(device_address_type) 0: Public address

*Default: 1 1: Random address

GATT Server Callback Number The number of callbacks to be registered
(gatt_server_callback_num) MIN: 1

*Default: 15 MAX: 15

GATT Client Callback Number The number of callbacks to be registered
(gatt_client_callback_num) MIN: 1

*Default: 15 MAX: 15

Vender Specific Callback
(vender_specific_callback)
*Default: NULL

Callback of completing BD address setting with open
API of Bearer Platform
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3.5 Add and configure related module
The MESH Stack uses the following peripherals to perform MESH communication.

Table 3-11 Related peripherals

Item Usage

Bluetooth Low Energy Driver (r_ble_extended or Bluetooth Low Energy communication
r_ble_extended_freertos)

General PWM Timer Driver (r_gpt) Timer (g_timer0) for Bluetooth Mesh Stack
Timer (g_timer1) for Bluetooth LE Stack

Low-Power Flash Driver (r_flash_Ip) Store Bonding information etc.

Interrupt Controller Unit Driver (r_icu) Interrupt (g_external_irq0) from BLE(H/W)
Interrupt (g_ble_sw_irq) from switch(H/W)

Serial Communication Interface Driver (r_sci_uart) Serial communication

Low Power Modes Driver (r_Ilpm) Low Power Modes of MCU

This section describes how to configure related peripherals (timers, interrupt) for MESH Stack which added
in previous section. Procedure describes in this section is common to BareMetal and FreeRTOS
environment.
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3.5.1 r_gpt (g_timero0)
1. Click Add Timer Driver box and select New—->Timer, General PWM (r_gpt).

% *[sample_appl] FSP Configuration X =0

Stacks Configuration Generate Project Content
Threads = HAL/Common Stacks <1 New Stack >
~ i HAL/Common

4 g_ioport I/O Port (r_ioport}

& BLE Mesh Bearer Platform (rm_mesh_bearer_platform)

% BLE Mesh Bearer Platform (rm_mesh bearer_platform)

% BLE Mesh Bearer (rm_ble_mesh bearer)

% BLE Mesh (rm_ble_mesh)

ry

T T t
4 BLE Mesh OS on 4 BLE Mesh Timer on % Add Timer Driver & g_flashO Flash @ BLE Driver (r_ble_exi
Baremetal Baremetal (r_flash_Ip)
Objects (rm_mesh_os_baremet (rm_mesh_timer_bare
al) metal) o 1o
New > & Timer, General PWM (r_gpt)
% Timer, Low-Power (r_agt)
(r_flash_Ip)
N
< >

Summary BSP | Clocks|Pins | Interrupts [ Event Links| © Stacks| Components|

Figure 3-24 Add GPT for Bluetooth Mesh Stack

2. Set Overflow/Crest Interrupt Priority of g_timer0 Timer, General PWM (r_gpt) as Priority 3 on
Properties tab.

W Properties X [HSSE I W ESl bl a
g_timer0 Timer, General PWM (r_gpt)
Settings Property Value
APl Info |  Commen
Parameter Checking Default (BSP)
Pin Output Support Disabled
Write Protect Enable Disabled
Clock Source PCLKD
~ Module g_timer0 Timer, General PWM (r_gpt)
General
Qutput
Input
v Interrupts
Callback NN
I Overflow/Crest Interrupt Priority Priority 3 I
Capture A Interrupt Priority Disabled
Capture B Interrupt Priority Disabled
Underflow/Trough Interrupt Priority Disabled
<

Select the overflow interrupt priority. T..he crest interrupt for triangle-wave PWM.

Figure 3-25 GPT configuration for Bluetooth Mesh Stack

RO1AN5848EJ0105 Rev.1.05 Page 33 of 43
Dec. 16, 2022 RENESAS



RA4W1 Group Bluetooth Mesh sample application

3.5.2 r_flash_Ip
Configure as following.

1. Set the Data Flash Background Operation of g_flash0 Flash (r_flash_Ip) as Disabled on Properties
tab.

8 properties x [HEEE I SN

g_flashO Flash (r_flash_lp)

Settings  Property Value

APl Infg | ™ Common
Parameter Checking Default (BSP)
Code Flash Programming Disabled
Data Flash Programming Enabled

v Module g_flash0 Flash (r_flash_Ip)

Name g_flasho
Data Flash Background Operation Disabled
Callback NULL
Flash Ready Interrupt Priority Disabled

Enabling allows Flash API calls that ref.. operation continuing in the background.

Figure 3-26 Flash configuration
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r_icu (g_external_irq0)

BareMetal environment
Priority O on Priority.

Set Pin Interrupt Priority of g_external_irq0 External IRQ (r_icu) as the followings.

g_external_irq0 External IRQ (r_icu)

Property
v Common

Settings

APl Info
Parameter Checking

v Module g_external_irg0 External IRQ (r_icu)

Value

Default (BSP)

MName g_external_irg0

Channel @8

Trigger & Falling

Digital Filtering Disabled

Digital Filtering Sample Clock (Only valid whe PCLK / 64

Callback Gl ble '||;|‘_r§|;mg1
I Pin Interrupt Priority Priority 0 (highest)
v Pins

IRGO8 <unavailable>

Select the PIN interrupt priority.

Figure 3-27 ICU configuration (BareMetal Environment)

FreeRTOS environment
Priority 1 on Priority. Because it is the highest priority used by the FreeRTOS kernel.

g_external_irq0 External IRQ (r_icu)
Settings Property Value
APl Info | ¥ Common
Parameter Checking Default (BSP)
v Module g_external_irg0 External IRQ (r_icu)
MName g_external_irg0
Channel @8
Trigger & Falling
Digital Filtering Disabled
Digital Filtering Sample Clock (Only valid whe PCLK / 64
Callback Sl ble interrupt
I Pin Interrupt Priority Priority 1
v Pins
IRGO8 <unavailable=

Select the PIN interrupt priority.

Figure 3-28 ICU configuration (FreeRTOS Environment)
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3.5.4 r_gpt (g_timer1)
1. Click Add GPT Driver box and select New->Timer, General PWM (r_gpt).

£+ [sample_appl] FSP Configuration %

= B8
Stacks Configuration o
9 Generate Project Content
Threads % New Thread #.|Remove | BLE Mesh Bearer Platform (rm_ble_mesh_bearer_platform) Stacks 4| New Stack >
v & HAL/Common = Mesh Bearer (rm_ble_mesh _bearer) ~
4 g_ioport I/O Port (r_iopart)
4 FreeRTOS Port (rm_freertos_port)
4 FreeRTOS Heap 4 -
~ 4 BLE_CORE_TASK L
4% BLE Mesh Bearer Platform (rm_ble_mesh_bearer_platform) = Mesh (rm_ble_mesh)
T T - T
= Mesh OS on 4 BLE Mesh Timer on 4 BLE Driver (r_ble_extended_freertos)
eRTOS FreeRTOS
1_mesh_os_freertas) (rm_mesh_timer_freert
os) @
Objects 4| New Object > I 4 T
 g_flash0 Flash # g_external_irg0 % Add GPT Driver
(r_flash_Ip) External IRQ (r_icu)
® 4+ Timer, General PWM (r_gpt) New >
@ Timer, Low-Power (r_agt) a
< >
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks| Components

Figure 3-29 Add GPT for Bluetooth LE Stack

2. Set Overflow/Crest Interrupt Priority of g_timer1 Timer, General PWM (r_gpt) as Priority 2 on
Properties tab.

g_timer0 Timer, General PWM (r_gpt)

Settings  Property Value
APl Info | > Common
v Module g_timer0 Timer, General PWM (r_gpt)
General
Output
Input
v Interrupts

Callback £ 0 0f host fimer |
Overflow/Crest Interrupt Priority Priority 2

Ca-pture A Inm Disabled
Capture B Interrupt Priority Disabled
Underflow/Trough Interrupt Priority Disabled
Extra Features
w Pins
GTIOCA <unavailable>
GTIOCB <unavailable >

Select the overflow interrupt pri... interrupt for triangle-wave PWM.

Figure 3-30 GPT configuration for Bluetooth LE Stack
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3.5.5 r_icu(g_ble_sw_irq)
If you use a switch on EK-RA4W1, set the configuration as the followings.

1. Click New Stack and add Input->External IRQ Driver (r_icu) to HAL/Common.
=5

Stacks Configuration Generate Project Content
Threads 4| New Thread = HAL/Common Stacks 4| New Stack ~
& HAL/Common Analog i
i 48 N do 48 s
& o oport /0 Port (1 iopor) & g,!oponlfo Port % FreeRTOS Port 4 FreeRTOS Heap 4 Artlf_lml Intelligence 2
o (r_ioport) (rm_freertos_port) Audio >
4 FreeRTOS Port (rm_freertos_port) Bootloader N
4% FreeRTOS Heap 4 ® ® o)
~ gt BLE_CORE_TASK CapTou(rh >
@ BLE Mesh Bearer Platform (rm_ble_mesh_bearer_platform) EmREI ’
@ BLE Mesh Model Generic On Off Server (rm_mesh_generic_ Dsp ’
Graphics >
-+ External IRQ (r_icu) Input >
4 Key Matrix (r_kint) Monitoring >
Motor >
Networking >
Power >
< > RTOS 2
. 5 Security >
Objects 4 New Object > Sensor >
Storage >
System >
Timers >
Transfer >
4 Search..
Summary BSP | Clocks | Pins |Interrupts  Event Links | ©@ Stacks| Components
Figure 3-31 Add ICU Driver
2. Set g_external_irq1 External IRQ (r_icu) as the following.
. [Name] : g_ble_sw irq
. [Channel] : 4
. [Trigger] : Falling
. [Callback] : Callback_ble_sw_irq
. [Pin Interrupt Priority] : Priority 2
g_external_irg1 External IRQ (r_icu)
Settings Property Value
APl Infg | Common
Parameter Checking Default (BSP)
~ Module g_ble_sw_irg External IRQ (r_icu)
Name g_ble_sw_irq
Channel 4
Trigger Falling
Digital Filtering Disabled
Dig_ital Filtering Sample Clock (Only valid whe PCH( /64
Callback Callback_ble_sw_irq
Pin Interruet Priority Priority 2
~ Pins
IRQO4 <unavailable>
Module name.
Figure 3-32 ICU Driver configuration
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3.5.6 r_sci_uart

If you use the Command Line Interface (CLI) to perform serial communication with the EK-RA4W1, set the
configuration as the following.

3.5.6.1 Related source files

Source files related to the CLI are installed under ./src/app_lib in this demo project. The user can add the CLI
functionality by copying the app_lib directory from this demo project to another project.

3.5.6.2 Configurations of SCI

Open the FSP configuration of user’s project and select the Stacks tab. Add New
Stack->Connectivity=>UART (r_sci_uart) to HAL/Common. Modify configuration of the added r_sci_uart
as the following.

. [General]>[Channel] : 4
. [Interrupts]—>[Callback] : user_uart_callback_ble_cli
. [Interrupts]>[xxx Interrupt Priority] : Priority 2
e [Pins]>[TXD] : P205
«  [Pins]>[RXD] : P206
g_uart0 UART (r_sci_uart)
Settings Property Value
APl Info | * Common
~ Module g_uart0 UART (r_sci_uart)
~ General
Name g uart0
I Channel 4 I
Data BIts Bbits
Parity None
Stop Bits 1bit
Baud
Flow Control
Extra
WUnT
Callback user_uart_callback_ble_cli
Receive Interrupt Priority Priority 2
Transmit Data Empty Interrupt Priority Priority 2
Transmit End Interrupt Priority Priority 2
ErTor Interrupt Priority Prigrity 2
v Pil‘l_s
TXD P205
RXD P206
CT1s <unavailable >
Select the SCI channel.
Figure 3-33 UART configuration
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3.5.6.3 Designating module name

Edit the value of BLE_UART _INSTANCE macro in app_lib / r_ble _console.c if the module name of the
r_sci_uart has been changed from g_uart0.

/******************************************************************************

Macro definitions
*******************************************************************************/

#define BLE_TX_BUFSIZ (180)
#define BLE_UART INSTANCE (g_uarte)

Code 1. BLE_UART_INSTANCE macro

3.5.6.4 Serial data output of UART

The serial data output of UART can be invoked by using the R_BLE CLI_Printf() function.
R _BLE CLI_Printf() function can generate formatted character lines similar to the printf() function.

Table 3-12 Syntax of R_BLE_CLI_Printf()
HIGTS LN ET W R BLE CLI_Printf

e void R_BLE_CLI_Printf(const char *format, ...);
Return void -
W const char *format Designate a constant character line including formats
Variable number of arguments represented by formats can be
designated.
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3.5.7 r_lpm

If you use the low power mode of the MCU, configure as following.

2. Click New Stack and add Power->Low Power Modes (r_lpm) to HAL/Common.

¥ *[sample_appl] FSP Configuration X

=0

Stacks Configuration

Threads <] New Thread =)

~ &F HAL/Common
4 g_ioport1/Q Port (r_ioport)
4 FreeRTOS Port (rm_freertos_port)
4 FreeRTOS Heap 4
@ g _ble_sw_irq External IRQ (r_icu)
@ g_uartd UART (r_sci_uart)
~ g# BLE_CORE_TASK
@ BLE Mesh Bearer Platform (rm_ble_mesh_bearer_platform)
@ BLE Mesh Madel Generic On Off Server (rm_mesh_generic_

Objects | New Object >

HAL/Common Stacks

Generate Project Content

& New Stark ~ =& Evtand Crark ~ & Rammug

FreeRTOS Port # FreeRTOS Heap 4 # g_ble_sw_irq External + g uart0 UART (r_
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6] @ ()
—_—

<
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CapTouch
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Figure 3-34 Add LPM
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RA4W1 Group Bluetooth Mesh sample application

3.6 Generate Code

[sH
Click [Generate] button '-EJ on the FSP Configuration.
API header, library, code, data, and the configuration files of each modules are generated in “ra”, "ra_gen",

“ra_cfg” folders of the project.
B Project Explorer % [RSICRTEE Sial=

~ = sample_appl [Debug]
» b Includes
~ Era
= arm
= aws
v (= fsp
& inc
= lib
(= src
~ [ ra_gen
[€ ble core task.c
[8 ble_core_taskh
[n bsp_clock_cfg.h
[¢ common_data.c
[8 common_data.h
[€ hal_data.c
[8 hal datah
[€ main.c
[€ pin_data.c
[¢ vector_data.c
[n vector data.h
v [ src
[£ ble_core_task_entry.c
[€ hal_entry.c
~ [= ra_cfg
= aws
= fsp_cfg
= script
& configurationxml
R7FAAWIADZCNG.pincfg
ra_cfg.txt
sample_appl Debug_Flatlaunch
(@ Developer Assistance

| TR

[

< >

Figure 3-35 Result of Code Generation

3.7 Building and debugging

Refer to section 2.2.
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RA4W1 Group Bluetooth Mesh sample application

4. How to Implement Mesh Applications

Regarding how to implement mesh applications using the Mesh Stack, refer to "RA4W1 Group Bluetooth
Mesh Development Guide" (RO1AN5849).
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5. Appendix

5.1 Program Size
Table 5 1 shows the program size of demo project.

Table 5-1 Program Size

Project ROM Size RAM Size
ekradw1_mesh_cli_client_baremetal 510KB 52KB
ekradw1_mesh_cli_server_baremetal 477KB 53KB

ekradw1_mesh_client_baremetal 334KB 48KB
ekradw1_mesh_client_freertos 348KB 82KB
ekradw1_mesh_server_baremetal 335KB 48KB
ekradw1_mesh_server freertos 349KB 82KB
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Trademark and Copyright

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of
such marks by Renesas Electronics Corporation is under license. Other trademarks and registered
trademarks are the property of their respective owners.

RA4W1 Group Bluetooth Mesh Stack uses the following open source software.

crackle; AES-CCM, AES-128bit functionality
BSD 2-Clause License

Copyright (c) 2013-2018, Mike Ryan
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 1S"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,

OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


https://github.com/mikeryan/crackle

Revision History

Rev. Date Description
1.00 Feb. 25, 2022 - First edition
1.01 Apr. 27, 2022 P.21 Changed Total Heap Size from 10240 to 11264.
- Updated attached demo project.
1.03 Aug. 29, 2022 P.8 Updated software requirements.
P.25 Added a note to set the same value to the properties of the BLE Mesh Bearer
Platform and BLE Driver box.
- Updated attached demo project.
1.04 Oct. 26, 2022 P.8 Updated software environment.
- Updated attached demo project.
1.05 Dec. 16, 2022 P.8 Updated software environment.
P. 27 Updated FSP Configuration parameters.

Updated attached demo project.




General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2022 Renesas Electronics Corporation. All rights reserved.


https://www.renesas.com/
https://www.renesas.com/contact/

	1. Overview
	1.1 Demo projects
	1.2 Mesh Stack features
	1.3 Software Architecture
	1.4 File Composition
	1.5 API Specification
	1.6 Operating environment

	2. How to use demo project
	2.1 Importing demo project
	2.2 Building and debugging

	3. How to make and configure new project
	3.1 Create a New Project
	3.2 Heap and Stack configuration
	3.3 Clocks configuration
	3.4 Add and configure MESH Stack
	3.4.1 Add MESH Stack in BareMetal environment
	3.4.2 Add MESH Stack in FreeRTOS environment
	3.4.3 Configure Mesh Stack
	3.4.4 Oher Mesh Stack configuration

	3.5 Add and configure related module
	3.5.1 r_gpt (g_timer0)
	3.5.2 r_flash_lp
	3.5.3 r_icu (g_external_irq0)
	3.5.4 r_gpt (g_timer1)
	3.5.5 r_icu (g_ble_sw_irq)
	3.5.6 r_sci_uart
	3.5.6.1 Related source files
	3.5.6.2 Configurations of SCI
	3.5.6.3 Designating module name
	3.5.6.4 Serial data output of UART

	3.5.7 r_lpm

	3.6 Generate Code
	3.7 Building and debugging

	4. How to Implement Mesh Applications
	5. Appendix
	5.1 Program Size

	Revision History

